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INTRODUCTION

In 1979 a test embankment was constructed in the Netherlands near the town of Almere. The
objective of this test was to measure the influence of geotextile reinforcement on the short
term stability of an embankment on soft soil. Two test embankments were constructed on top
of a layer, one with and one without geotextile. The construction procedure was such that a
ditch was excavated in the clay layer while at the same time a retaining bank was made with
the excavated clay. A cross-section of the reinforced test embankment is given in figure 1.
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Figure 1: Cross-section of the reinforced embankment

Cone penetration tests gave an average cone resistance of qc = 150 kPa for the clay. The clay
is considered to be normally consolidated. The behaviour is assumed to be undrained (the
retaining bank should be drained, however). The saturated weight of the clay is 13.5 kN/m3.
A plasticity index of Ip = 50% is assumed. Due to the limited soil data, parameters should
be selected using engineering judgement and by using the correlations given in the lecture
"Evaluation of soil stiffness parameters". To obtain an undrained shear strength for the clay
layer it is suggested to use the correlation su ≈ qc/15. Having no data for the effective cohesion
and the effective friction angle, they have to be estimated from the undrained shear strength in
order to do a consolidation analysis. For the determination of a stiffness parameter for the clay
layer it is suggested to use the correlation Eu ≈ 15000 · su/Ip(%). The shear modulus G is one
third of the undrained Young’s modulus Eu. The effective Poisson’s ratio should be chosen
such that a realistic Knc

0 is obtained in one-dimensional compression (Knc
0 = ν ′/(1−ν ′) ≈ 0.5).

The effective Young’s modulus is calculated from the shear modulus E ′ = 2G(1 + ν ′). The
fill was reported to be fully saturated loose sand with a saturated weight of 18 kN/m3. The
behaviour is considered to be drained. The effective strength properties are estimated at ϕ′ =
30° and c’ = 3 kPa. Knc

0 is assumed at 0.5. For the stiffness one should take E’ = 4000 kPa
and ν ′=0.33.
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AIMS

• Calculation of two alternatives within one project.

• Simulation of embankment construction in stages.

• Application of geogrid elements

• Review of undrained behaviour and pore pressures.

• Perform consolidation analysis.

• Determination of the factor of safety using phi/c reduction

SCHEME OF OPERATIONS

1. Determination of stiffness & strength properties (clay)

2. Geometry input

(a) Start a new project

(b) Enter general settings

(c) Enter geometry

(d) Enter fixities

(e) Enter material properties for soil and geotextile

(f) Mesh generation + refine line

3. Calculation

(a) Initial conditions (Pore pressure generation, Initial geometry configuration, Genera-
tion of initial stresses)

(b) Switch on geotextile, excavate ditch + raise retaining embankment

(c) Apply first hydraulic fill

(d) Apply second hydraulic fill

(e) Determine factor of safety

(f) Repeat this using consolidation phases instead of plastic phases.

4. Inspect output

5. Suggestion for extra exercise: non-reinforced embankment
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Note: The main purpose of the exercise is to assess the failure mechanism and
the factor of safety, which has the following consequences for the model:

• There is no need to use an advanced soil model as the main
advantage of advanced models is a better prediction of
displacements.

• The geometry size is chosen such that the failure mechanism fits
within the model boundaries. This means the geometry can be fairly
small.

If a deformation analysis has to be performed for this case it is
recommended to use an advanced soil model, for instance the Hardening
Soil or HSsmall model, and to choose the geometry considerably larger to
avoid influence from the boundary conditions on the results.
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GEOMETRY INPUT

General settings

Start a new project and select appropriate General settings. Use 15-node elements as basic
element type since in this exercise we will deal with failure behaviour.

Geometry and boundary conditions
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Figure 2: Geometry model with coordinates

• Enter the geometry as indicated in the previous graph. The order in which geometry
points are created is arbitrary.

• Click the Geogrid button to introduce the geotextile (from (4.5, 5.5) to (26.0, 5.5)).

• Click the Standard fixities button for the standard boundary conditions.

Material properties (clay)

Determine the Mohr-Coulomb strength parameters (ϕ and c) as well as the elastic parameters
(E’ and ν’) for the clay layer from the data as given in the introduction of this exercise. The
procedure on how to determine the parameters for clay are provided at the end of this exercise.
For this exercise, we will continue with the parameters as given in table 1.

Soil and interfaces

• Enter the material properties for the three soil data sets, as indicated in table 1.

• After entering all properties for the three soil types, drag and drop the properties to the
appropriate clusters, as indicated in figure 3.
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Table 1: Soil parameters

Parameter Symbol Clay Retaining
bank

Fill Stiff layer Unit

Material model Model Mohr-
Coulomb

Mohr-
Coulomb

Mohr-
Coulomb

Mohr-
Coulomb

–

Type of behaviour Type Undrained A Drained Drained Drained –
Unsaturated weight γunsat 13.5 13.5 18.0 18.0 kN/m3

Saturated weight γsat 13.5 13.5 18.0 18.0 kN/m3

Young’s modulus E 2667 2667 4000 40000 kN/m2

Poisson’s ratio ν 0.33 0.33 0.33 0.33 –
Cohesion c 8.0 8.0 3.0 3.0 kN/m2

Friction angle ϕ 20.0 20.0 30.0 32.0 ◦

Dilatancy angle ψ 0.0 0.0 0.0 2.0 ◦

Permeability x-dir kx 1.0·10−3 1.0 1.0 1.0 m/day
Permeability y-dir ky 1.0·10−3 1.0 1.0 1.0 m/day

K0 Automatic Automatic Automatic Automatic –
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Figure 3: Geometry model with soil material sets
(1) Clay, (2) Retaining bank, (3) Fill and (4) Stiff layer

Geotextile

• In the project database select the data type Geogrids and create a new material set. In
this material set, enter 2500 kN/m as stiffness. Note that this is the stiffness in extension.
In compression no stiffness is used.

• Drag the geogrid data set to the geotextile in the geometry and drop it there. The
geotextile should flash red once, indicating the properties have been set.

Mesh generation

• From the Mesh menu select the option Global coarseness. In the window that appears,
set the mesh coarseness to Medium and click on the Generate button, which will present
the following FE mesh composed of 15-node elements.
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Figure 4: Medium coarse generated mesh

• Select the clay layer (this consists of two clusters, see also hint) and press Refine cluster
from the Mesh menu. This will result in a refinement in the clay layer that will be needed
for the consolidation analysis. See figure 5.

Close the window showing the generated mesh and continue to the Calculations program.

Figure 5: Mesh with cluster refinement
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CALCULATION

The calculation consists of two alternatives for the construction of the embankment: without
and with consolidation taken into account. After both alternatives the factor of safety is
determined. In the calculations list 8 phases are needed, 4 phases for each alternative. First
start with the fully undrained construction, that is without taking consolidation into account.
When starting Plaxis Calculations, choose Classical mode.

Initial conditions

• Select the initial phase in the phase list and then press the Define button on the Para-
meters tabsheet in order to define the initial phase. The input window now opens in
Staged Construction mode.

• Deselect all material clusters and geotextile elements that are not present at the start of
the analysis. As we want to model the entire construction sequence from the beginning,
switch off:

– Geotextile elements

– Material clusters for the fill

– Material cluster for retaining bank

• Now continue to the Water conditions mode by clicking the equally named button.

• Enter a phreatic level at ground level by two coordinates (0, 5.5) and (33, 5.5). Click on
the Water pressures button to generate the pore pressures.

Phase 1: Excavation of the ditch and construction of the retaining bank

This calculation phase is a Plastic analysis, with loading type Staged construction. For all the
other settings the defaults should be used. In this phase:

• Activate the full geotextile

• Construct the retaining bank

• Excavate the ditch (left of the embankment)

Phase 2: First fill

• This calculation phase is also a Plastic analysis with the Staged construction loading
type. For all the other settings the defaults should be used. In this phase the first layer
of fill must be switched on.
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Phase 3: Second fill

• This calculation phase is again a Plastic analysis, loading type Staged construction. For
all the other settings the defaults should be used. Switch on the second layer of fill.

Phase 4: Safety factor determination

• This calculation phase is a Safety phase. The loading type will be set automatically.
Keep all default settings.

After this, we will construct the embankment taking into account consolidation:

Phase 5: Consolidated construction of the ditch and retaining bank

This phase starts an alternative calculation, so phase 5 should NOT follow on phase 4 as is the
default, but it should follow on the initial phase. To do so, on the General tabsheet set Start
from phase to the Initial phase. This calculation phase is a Consolidation analysis, loading
type Staged construction. We assume that construction of the ditch and retaining bank will
take 3 days. Hence, in the Loading Input box fill in a Time Interval of 3 days. During this time
interval construction will take place, as well as consolidation. For all the other settings the
defaults should be used. In this phase again:

• Switch on the full geotextile

• Construct the retaining bank

• Excavate the ditch (left of the embankment)

Phase 6: First fill - consolidated

This calculation phase is also a Consolidation analysis, loading type Staged construction. We
assume that making the hydraulic fill will take 7 days, so the Time interval should be set on 7
days. For the rest this phase is equal to phase 2; hence the first layer of fill must be switched
on.

Phase 7: Second fill - consolidated

This calculation phase is again a Consolidation analysis, loading type Staged construction.
This second fill will take 3 days, so the Time interval should be set on 3 days. For all the other
settings the defaults should be used. In staged construction, switch on the second layer of fill.
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Phase 8: Safety factor determination

This calculation phase is a Safety phase. The loading type will be set automatically. Keep all
default settings.

Select points for load-displacement curves

As node for load-displacement curves, select the toe of the embankment and start the calcu-
lation.
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INSPECT OUTPUT

In order to get a good idea of the displacement mechanism, one can view the contours
of incremental displacements. Figure 6 shows this plot of the final calculation step for the
undrained construction. It clearly shows the effect of the geotextile reinforcement. Figure 7
shows the incremental displacement for the consolidated construction. Here the embankment
has a more gradual settlement without showing an upcoming failure mechanism.

Figure 6: Incremental displacements contours, undrained (phase 3)

Figure 7: Incremental displacement contours, consolidated (phase 7)

The axial forces of the geotextile can be visualised by double clicking on the geotextile. This
will first present the displacement of the geotextile. On using the menu item Forces, one can
select Axial forces N.

Figure 8: Axial forces in geotextile, undrained (phase 3)

At the ends of the geotextile the axial force must be zero, but due to the discretisation and
some numerical inaccuracy this is not completely achieved. The maximum axial forces is
approx. 8 kN/m. figure 9 shows the axial forces for the consolidated construction. The
maximimum axial force here is only 5-6 kN/m.
Finally, the factors of safety are checked. In order to do so follow these steps:

• Start the curves manager by selecting the Curves manager option from the Tools menu.
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Figure 9: Axial forces in geotextile, consolidated (phase 7)

• In the curves manager (see figure 10) select New in the Charts tabsheet. This presents
the Curve Generation window as shown in figure 11.

• On the x-axis we want to show the displacements of the point at the toe of the embank-
ment, hence choose Point A and Deformations → Total displacements → |u|.

• On the y-axis we want to show the strength reduction factor, hence select Project and
Multiplier → ΣMsf on the y-axis.

Figure 10: Curves manager

The created curve indicates a safety factor around 1.4 for the undrained construction and a a
safety factor of 2.1 for the consolidated construction of the embankment, as can be seen in
figure 12.
From the graph above, the factor of safety can be determined. Always look for a steady state
solution (slight variations in the load multipliers, increasing displacements). In most case, the
phi/c reduction calculation shows some variation at the beginning of the calculation. Note
that the displacements resulting from a Safety analysis are non-physical. Hence the total
displacements are not relevant. An incremental displacement plot of the last step, however,
shows the failure mechanism that corresponds the calculated value for ΣMsf .
Addicionally, figures 13 and 14 show the failure mechanisms with the lowest factor or safety
for both the undrained and consolidated case.
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Figure 11: Curve generation window

Consolidated: ΣMsf=2.1

Undrained: ΣMsf=1.4

Consolidated: ΣMsf=2.1

Undrained: ΣMsf=1.4

Figure 12: Safety factor curve for reinforced embankment
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Figure 13: Incremental displacements, undrained (phase 4)

Figure 14: Incremental displacements, consolidated (phase 8)
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SUGGESTION FOR EXTRA EXERCISE: NON-REINFORCED
EMBANKMENT

SCHEME OF OPERATIONS

• For the undrained construction of an embankment, now introduce phase (9). In the Start
from phase list box select <0 – initial phase>. This phase as well as phases 10 and 11
are Plastic analyses. Excavate the ditch and construct the embankment, but do NOT
activate the geotextile.

• In the next phase (10) the first part of the fill is activated.

• In the next phase (11) the second part of the fill is activated.

• In the next phase (12) perform a safety analysis. In principle we can keep the 100
additional steps for this calculation. However, 50 additional steps is already sufficient
here.

• For the consolidated construction of the embankment, now introduce phase (13). In the
Start from phase list box select <0 – initial phase>. This phase as well as phases 14 and
15 are Consolidation analyses. Set the Time interval to 3 days, excavate the ditch and
construct the embankment, but do NOT activate the geotextile.

• In the next phase (14) the first part of the fill is activated. Set the Time interval to 7 days.

• In the next phase (15) the second part of the fill is activated. Set the Time interval to 3
days.

• Finally, in the last phase (16) perform a Safety analysis again. In principle we can keep
the 100 additional steps here as well. However, 30 additional steps is already sufficient
to obtain a reliable value.

Presented below is both the incremental displacement plot as well as the incremental shear
strain plot of both the drained and consolidated non-reinforced embankment after safety ana-
lysis. Hence, the plots show the failure mechanisms.

Figure 15: Incremental displacements, undrained (phase 12)

FACTORS OF SAFETY

The factors of safety are checked with the Curves program, see figure 19.
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Figure 16: Incremental shear strains, undrained (phase 12)

Figure 17: Incremental displacements, consolidated (phase 16)

Figure 18: Incremental shear strains, consolidated (phase 16)

Consolidated: ΣMsf=1.4

Undrained: ΣMsf=1.1

Consolidated: ΣMsf=1.4

Undrained: ΣMsf=1.1

Figure 19: Safety factor curve for non-reinforced embankment
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SUGGESTIONS FOR THE DETERMINATION OF THE CLAY
PARAMETERS

su ≈ qc
15

= 150
15

= 10 kPa
su = 1

2

(
σ,0
x + σ,0

y

)
sin(ϕ) + c cos(ϕ) with σ0

x = K0 · σ,0
y ≈ (1− sin(ϕ)) · σ,0

y

In the middle of the clay layer at about 2m below ground level:
σ,0
y = h · (γsat − γwater) = 2 · 3.5 = 7 kPa =⇒ σ,0

x = (1− sin(20)) · σ,0
y = 4.6 kPa

For this clay estimate ϕ = 20º, then c ˜ 8 kPa
Eu ≈ 15000·su

50
= 15000·10

50
= 3000 kPa

G = 1
3
Eu = 1

3
· 3000 = 1000 kPa

E ′ = 2G(1 + ν) = 8
3
·G = 2667 kPa

ν = K0

1+K0
= 0.5

1.5
= 0.33

Use ‘Undrained A’ as the type of material behaviour.
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